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1. About the SortalGI plug-in
A shape rule combines a speciﬁcaEon of recogniEon and manipulaEon. A shape rule is
commonly speciﬁed in the form lhs → rhs, where the leJ-hand-side (lhs) of the rule speciﬁes
the pa<ern to be recognized and the manipulaEon of the current shape then involves
replacing the recognized lhs by the right-hand-side (rhs) of the shape rule in the shape under
invesEgaEon. RecogniEon necessarily applies under some transformaEon, for example, a
similarity transformaEon, and the resulEng manipulaEon must occur under the same
transformaEon for both lhs and rhs. That is, applying a rule a → b to a given shape s involves
determining a transformaEon f such that f(a) is a part of s (f(a) ≤ s), following which s is
replaced by s – f(a) + f(b).
A shape grammar generally deﬁnes a collecEon of rules together with an iniEal shape; then,
the language deﬁned by a shape grammar is the set of shapes generated by the rules from
the iniEal shape. However, from a user’s point of view, any collecEon of rules that serves a
parEcular purpose can be considered a shape grammar, whether or not it requires a
parEcular iniEal shape or, instead, can be applied to a wide variety of (iniEal) shapes.
Sortal grammars extend on shape grammars. Where shape grammars commonly rely on a
combinaEon of line segments and labelled points, sortal grammars take a modular
representaEonal approach, allowing for a wide variety of geometric and non-geometric
elements to be included in the speciﬁcaEon of shape rules and grammars. Sortal grammars
uElize sortal structures as representaEonal structures, where these structures are deﬁned as
formal composiEons of other, primiEve, sortal structures, termed sorts. As such, sortal
grammars consEtute a class of formalisms for design grammars and beneﬁt from the fact
that every component sort speciﬁes a parEal order relaEonship on its individuals and forms,
deﬁning both the matching operaEon and the arithmeEc operaEons for rule applicaEon.
A shape grammar interpreter is the engine that supports the applicaEon of shape rules,
including recogniEon and manipulaEon. The SortalGI plug-in for Grasshopper encapsulates
the SortalGI sortal/shape grammar interpreter and makes part of its funcEonality available
within Rhino/Grasshopper. It allows the user to create and apply shape and descripEon rules
within the Grasshopper environment.
Plug-in development by Bianchi Dy
System development by Bui Do Phuong Tung
Under the supervision of Rudi Stouﬀs

2. Installa=on and update
InstallaEon takes three steps. The ﬁrst step only needs to be performed once and only if you
are using Rhino 5. The second step is also required for any major update (e.g., from v0.2.2 to
v0.3.0), while the third step should be performed for any update, though in case of a minor
update (e.g., from v0.2.1 to v0.2.2), you may be able to simply use the SGI Update
component (see below).
You can ﬁnd the latest update from Food4Rhino (h<p://www.food4rhino.com/app/sortalgishape-grammar-interpreter) or sortal.org (h<p://www.sortal.org/downloads/plugin.html)
Step 1:Installing GhPython and upda=ng Rhino’s Module Search Paths
If you are using Rhino 5, you must install GhPython onto Rhinoceros Grasshopper. This is not
necessary if you are using Rhino 6. However, for both Rhino 5 and Rhino 6, you must update
Rhino’s Module Search Paths (steps b and e-j).
a) Download the GhPython Grasshopper Assembly ﬁle (gha) from Food4Rhino: h<p://
www.food4rhino.com/app/ghpython
b) Open Rhino and Grasshopper.
c) In Grasshopper, choose File > Special Folders > Components folder. Save the gha ﬁle
in this folder.
d) In the ﬁnder window, right-click the gha ﬁle > ProperEes and make sure there is no
"blocked" text.
e) Type EditPythonScript in the Rhino Command box.
f) In the Rhino Python Editor window, select 'OpEons...' from the Tools menu.
g) Add the Plug-ins\IronPython\Lib\site-packages folder of your Rhino installaEon
folder into the 'Module Search Paths'.
h) Switch from the ‘Files’ tab to the ‘Script Engine’ tab (in the Python OpEons window)
i) Check the ‘Frames Enabled’ opEon and click ‘OK’
j) Close Grasshopper and Rhino completely.
Step 2: Installing the SortalGI library
As the SortalGI library may change with a major update (e.g., from v0.2.2 to v0.3.0) and
there may be dependencies between the plug-in and such changes, it is strongly advised to
re-install the SortalGI library with every major update. This installaEon may be achieved in
one of two ways.
a) If you have not yet done so, download the latest SortalGI update Food4Rhino (h<p://
www.food4rhino.com/app/sortalgi-shape-grammar-interpreter) or sortal.org (h<p://
www.sortal.org/downloads/plugin.html) and unzip the ﬁle.
b) (in Windows) Run the setup widget inside the folder ‘sortal-setup’.
The computer may prompt for whether to allow the widget to make changes; click
‘Yes’ or ‘Allow’. Wait for it to ﬁnish installing the packages.
c) If you are unable to run the ‘setup’ widget, you may manually copy-paste the ﬁles in
their respecEve locaEons:
i.
Copy the content of the folder ‘sortal-setup\site-packages’ into the locaEon C:
\Program Files\Rhinoceros 5.0 (64-bit)\Plug-ins\IronPython\Lib\site-packages
or equivalent on your computer
ii. Copy the folder ‘sortal’ (inside ‘sortal-setup\sortal-packages’) into the
locaEon C:\Program Files\ Rhinoceros 5.0 (64-bit)\Plug-ins\IronPython\Lib

Step 3: Installing the SortalGI plug-in
With any update of the SortalGI plug-in, you must update the SortalGI components in
Grasshopper. You can:
a) Open Rhino and Grasshopper.
b) In Grasshopper, choose File > Special Folders > User Objects folder.
c) Copy all ﬁles from the folder 'components' and paste these into the folder
'UserObjects'.
The result should be automaEcally reﬂected in Grasshopper. There should be an ‘SGI’ in the
Grasshopper Components Tab Panel and if you select the tab it should include all the User
Objects. If not, you may want to restart Grasshopper and Rhino for the changes to take
eﬀect.
In case of a minor update (e.g., from v0.2.1 to v0.2.2), you can also use the SGI Update
component to update the SortalGI components in the Grasshopper Components Tab Panel
as well as in the current parametric model (see secEon 3. Star=ng on a SortalGI-based
parametric model).

3. Star=ng on a SortalGI-based parametric model
Crea=ng a new parametric model using SortalGI components
Before adding any other SGI component, you should ﬁrst add the SGI Setup component. This
component iniEalizes the SortalGI engine and makes all funcEonality available to the model.
If, instead, you add the SGI Setup component aJer other SGI components, you should use
F5 in order to ensure the SGI Setup component is executed before all other components.
SGI Setup

The SGI Setup component iniEalizes the SortalGI engine and allows for some global senngs.
Inputs:
− displacementX: opEonal displacement value along the X-axis for the purpose of
translaEng any shape resulEng from a rule applicaEon; if no displacement value is
speciﬁed, then the rule applicaEon will automaEcally derive the translaEon distance
from the bounding box of the shape (see secEon 6. Applying a rule)
− displacementY: opEonal displacement value along the Y-axis for the purpose of
translaEng and spacing mulEple shapes resulEng from a rule applicaEon; if no
displacement value is speciﬁed, then the rule applicaEon will automaEcally derive
the translaEon distance from the bounding box of the shape (see secEon 6. Applying
a rule)
− text size: the text size to visualize any labels or shape descripEons that are a<ributes
to geometries resulEng from a SortalGI component
− descrip7ons: a list of shape descripEon types, each idenEﬁed by its name (see
secEon 7. Specifying shape descrip=ons for a speciﬁcaEon of descripEons)
Outputs:
− check: True or False value indicaEng success of the setup
Opening an exis=ng parametric model using SortalGI components
If you ﬁnd any errors with SortalGI components upon opening an exisEng parametric model,
these might be caused by having older components embedded in the exisEng model when
compared with the SortalGI version installed.
Firstly, check the version number of the speciﬁc component. If it is an older (or diﬀerent)
version number, you can use the SGI Update component to automaEcally update this and
any other components to the installed version. Note that any embedded component in the
parametric model contains its own Python code and updaEng the SortalGI components in
the ‘UserObjects’ folder does not automaEcally update the embedded components in the
model. The SGI Update component will update both the SortalGI components in the
‘UserObjects’ folder (if instructed to do so) and the embedded components in the current
parametric model.
Secondly, if the version number does correspond to the installed version, instead, the
problem may relate to a diﬀerence in inputs and/or outputs between the speciﬁc embedded
component in the model and the component present in the Grasshopper Components Tab

Panel. In this case, you must replace the embedded component and all its connecEons using
the available component.
SGI Update
The SGI Update component updates the Python codes in the embedded components in the
parametric model to the speciﬁed SortalGI version. If speciﬁed, it will also update the
components in the Grasshopper Components Tab Panel.
Inputs:
− sourceDirectory: an opEonal source directory where the SortalGI components should
be copied from and into the ‘UserObjects’ folder; if you omit this source directory,
then only the Python codes of the embedded components in the parametric model
will be updated to the current SortalGI version as available in the Grasshopper
Components Tab Panel
− updateThisFile: True or False; senng this value to True will execute the SGI Update
component; senng it to False will keep it from execuEng over and over again
Outputs:
− success: True or False value indicaEng success of the update

4. Crea=ng a shape object
CreaEng shape objects using the SGI Shape or SGI dShape components serves diﬀerent
purposes. A shape object can be used to deﬁne the leJ-hand-side or the right-hand-side of a
rule. Rule applicaEon also requires a shape object as the input shape and, opEonally, as the
input subshape (see secEon 6. Applying a rule).
A shape object may consist of points, line segments and plane segments, as well as shape
descripEons. Points may have labels or shape descripEons assigned as a<ributes. The Text
Point component allows one to assign a label or shape descripEon as a text to a point. Note
that the resulEng geometry is only recognized by any of the SGI components, speciﬁcally
SGI Shape or SGI dShape. Other Grasshopper components will not recognize the text point.
The SGI Shape and SGI dShape components diﬀer in the fact that the la<er accepts shape
descripEons using an extra input, while the former does not.
Text Point
The Text Point component creates a labelled point object, that is, a point with a label or
shape descripEon as a<ribute.
Inputs:
− P: a point specifying the posiEon of the object
− label: a text specifying the label or shape descripEon of the object (see secEon 7.
Specifying shape descrip=ons for a speciﬁcaEon of descripEons)
Outputs:
− G: the resulEng text object
SGI Shape
The SGI Shape component creates a shape object from a geometry and an opEonal
reference point.
Inputs:
− G: a geometry of points, text points, lines, polylines, (ﬂat) surfaces, meshes and/or
boundary representaEons; any part of the geometry not recognized will be ignored
− refP: an opEonal reference point; if speciﬁed, the geometry will be moved from the
reference point to the origin, allowing a shape that will serve as the leJ-hand-side or
right-hand-side to a rule to be drawn or speciﬁed spaEally separated from the other
side of the rule
Outputs:
− S: the resulEng shape object
− G: the geometry of the shape object
SGI dShape

The SGI dShape component creates a shape object from a geometry, descripEons and an
opEonal reference point. The descripEons may be omi<ed, so may be the geometry, though
not both at the same Eme.
Inputs:
− G: a geometry of points, text points, lines, polylines, (ﬂat) surfaces, meshes and/or
boundary representaEons; any part of the geometry not recognized will be ignored
− D: one or more shape descripEons, each item preceded by the shape descripEon
type (name) and a colon; mulEple shape descripEons of the same type can be
combined into a single item by separaEng them with a verEcal bar
− refP: an opEonal reference point; if speciﬁed, the geometry will be moved from the
reference point to the origin, allowing a shape that will serve as the leJ-hand-side or
right-hand-side to a rule to be drawn or speciﬁed spaEally separated from the other
side of the rule
Outputs:
− S: the resulEng shape object
− G: the geometry of the shape object
− D: the shape descripEons of the shape object (note that any shape descripEon that is
assigned as an a<ribute to part of the geometry is not included as it already forms
part of the geometry)
SGI S2G
The SGI S2G component converts any shape object into its geometry and shape
descripEons.
Inputs:
− S: a shape object
Outputs:
− G: the geometry of the shape object
− D: the shape descripEons of the shape object (note that any shape descripEon that is
assigned as an a<ribute to part of the geometry of the shape object is not included
as it already forms part of the geometry)

5. Manipula=ng a shape object
Following the creaEon of a shape object, various geometrical operaEons are available as
SortalGI components to act upon a shape object; e.g., to translate/move a shape, rotate a
shape, reﬂect/mirror a shape and scale a shape. Each of these components takes as input a
shape object and any addiEonal data required to inform and apply the transformaEon, and
returns the resulEng shape object as well as the corresponding geometry and shape
descripEons. Their operaEon is quite idenEcal to the corresponding Grasshopper
components, except that they act upon a shape object.
In addiEon, there are SortalGI components to union/sum two shapes, intersect/take the
product of two shapes and take the diﬀerence of one shape with respect to another.
SGI Move Shape

The SGI Move Shape component moves a shape object along a vector. This component is
very useful to ensure the visualizaEon of shape objects resulEng from rule applicaEon do not
overlap and are properly spaced (see secEon 6. Applying a rule).
Inputs:
− S: a shape object
− T: a translaEon vector
Outputs:
− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object
SGI Rotate Shape

The SGI Rotate Shape component rotates a shape object about the normal vector of a base
plane by a speciﬁed angle.
Inputs:
− S: a shape object
− A: a rotaEon angle in radians
− P: a rotaEon plane
Outputs:
− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object
SGI Mirror Shape
The SGI Mirror Shape component mirrors a shape about a base plane.
Inputs:
− S: a shape object
− P: a mirror plane
Outputs:

− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object
SGI Scale Shape

The SGI Scale Shape component scales a shape object about a center of scaling uniformly by
a speciﬁed scaling factor.
Inputs:
− S: a shape object
− C: a center of scaling
− F: a scaling factor
Outputs:
− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object
SGI Sum
The SGI Sum component sums (combines) two shape objects together.
Inputs:
− S1: a shape object
− S2: another shape object
Outputs:
− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object
SGI Product

The SGI Product component determines the product (intersecEon) of two shape objects.
Inputs:
− S1: a shape object
− S2: another shape object
Outputs:
− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object

SGI Diﬀerence
The SGI Diﬀerence component takes the diﬀerence (complement) of one shape object with
respect to another shape object.

Inputs:
− S1: a shape object
− S2: another shape object
Outputs:
− S: the resulEng shape object
− G: the geometry of the resulEng shape object
− D: the shape descripEons of the resulEng shape object

6. Crea=ng a rule
A rule is conceptually speciﬁed in the form lhs → rhs, where the leJ-hand-side (lhs) of the
rule speciﬁes the pa<ern to be matched under some transformaEon and the right-hand-side
(rhs) speciﬁes the resulEng pa<ern that replaces the matched pa<ern under the same
transformaEon. That is, applying a rule a → b to a given shape s involves determining a
transformaEon f such that f(a) is a part of s (f(a) ≤ s), following which s is replaced by s – f(a)
+ f(b).
A shape rule is commonly understood to imply that both lhs and rhs consEtute a geometry,
possibly including non-geometric a<ributes, e.g., labels or descripEons. A descripEon rule,
then, implies that both lhs and rhs consEtute a shape descripEon of the same shape
descripEon type. Combining a shape rule with one or more descripEon rules speciﬁes a
compound rule, where the diﬀerent component rules operate in parallel, although they may
interact with each other.
A rule object speciﬁes such a compound rule although it can be used to specify a shape rule
or, alternaEvely, one or more descripEon rules. That is, which component rules are included
depends on the shape objects that are provided as lhs and rhs of the (compound) rule. If the
lhs does not include any geometry, then the rhs may not include any geometry either, as no
matching transformaEon can be determined from an empty shape. With respect to shape
descripEons, if either the lhs or rhs includes a shape descripEon type but the other side does
not, then an empty shape descripEon of that type is automaEcally included in the other side
to ensure a full correspondence between shape descripEon types (see secEon 6. Crea=ng a
rule).
SGI Rule
The SGI Rule component creates a rule object from a leJ-hand-side (lhs) and a right-handside (rhs), a name and a brief descripEon. If a shape descripEon type is present as part of
one shape object (lhs or rhs) but absent from the other shape object, an empty shape
descripEon of that type is automaEcally added to the other shape object within the rule.
Inputs:
− name: a rule name; this rule name should be unique
− desc: a brief explanaEon of the rule
− lhs: a shape object represenEng the leJ-hand-side of the rule
− rhs: a shape object represenEng the right-hand-side of the rule
Outputs:
− rule: the rule object
SGI Rule Info

The SGI Rule Info component deconstructs a rule object into its leJ-hand-side and
right-hand-side shape objects and provides a mulE-line text containing the rule object’s
GUID, name and descripEon.
Inputs:
− rule: a rule object

Outputs:
− info: a mulE-line text including the rule’s GUID, name and descripEon
− lhsS: the leJ-hand-side shape object
− rhsS: the right-hand-side shape object

7. Applying a rule
Applying a rule to a given shape object involves determining a transformaEon under which
the leJ-hand-side (lhs) of the rule is a part of the given shape. That is, rule applicaEon
involves two steps: recogniEon and manipulaEon; recogniEon implies matching the lhs of
the rule under some transformaEon to a part of the given shape and manipulaEon implies
replacing the recognized lhs by the right-hand-side (rhs) of the shape rule under the same
transformaEon.
Obviously, the lhs of a shape rule may match mulEple parts of the same given shape. These
matches may correspond to diﬀerent but similar parts, e.g., if the lhs speciﬁes a square, the
rule will match any square in the given shape independent of its locaEon, rotaEon or scale (a
similarity transformaEon). However, these matches may also apply to the same part in
diﬀerent ways. Again, if the lhs speciﬁes a square, which has 90° rotaEonal symmetry, and
the rhs speciﬁes the same square moved diagonally, then any square in the given shape will
amount to four matches as the square may be moved into any of its four diagonal direcEons.
The SortalGI plug-in disEnguishes two rule applicaEon components: the ﬁrst one, SGI Apply,
applies only a single match (either randomly selected or speciﬁed by its index), while the
second one, SGI Apply All, applies all matches in parallel, returning as many results as there
are matches. Both components accept both a shape object and an opEonal subshape object.
If speciﬁed, the la<er must be a subshape, that is, part of, the former. If a subshape object is
speciﬁed then recogniEon/matching is restricted to the subshape. This allows one to reduce
the number of matches where appropriate. ManipulaEon will always apply to the enEre
shape object.
Every resulEng shape is accompanied by a translaEon vector. In the case of SGI Apply, the
translaEon vector allows the resulEng shape to be visualized aside from the original shape,
along the X-axis. In the case of SGI Apply All, the translaEon vectors allow the resulEng
shapes to be visualized one above the other, along the Y-axis, and aside from the original
shape, along the X-axis. The extent of the translaEon vector is speciﬁed by the
displacementX and displacementX values provided to the SGI Setup component or, if no
value is provided, by the bounding box of the original shape (see secEon 3. Star=ng on a
SortalGI-based parametric model).
SGI Apply

The SGI Apply component.
Inputs:
− rule: a rule object
− S: a shape object to apply the rule to
− subS: an opEonal shape object to restrict matches to; if speciﬁed, this shape object
must be a subshape, that is, part of, the shape object S
− i: an opEonal index to select which match to consider for rule applicaEon; a value of
-1 (default) selects a random match, any number outside the index range yields the
last one among the list of matches
Outputs:

− S: the resulEng shape object upon rule applicaEon; if no match is found then the
original shape is returned
− G: the geometry of the resulEng shape object
− D: the descripEons of the resulEng shape object
− T: a translaEon vector to allow the resulEng shape to be drawn next to the original
shape, along the X-axis
− success: True or False indicaEng whether a match was found or not
SGI Apply All

The SGI Apply All component.
Inputs:
− rule: a rule object
− S: a shape object to apply the rule to
− subS: an opEonal shape object to restrict matches to; if speciﬁed, this shape object
must be a subshape, that is, part of, the shape object S
Outputs:
− L: a list of resulEng shape objects corresponding to the number of matches found; if
no match is found then the original shape is returned
− n: the number of matches found, corresponds to the length of the lists L and Ts
− Ts: a list of translaEon vectors to allow the resulEng shapes to be drawn one above
the other, along the Y-axis, and next to the original shape, along the X-axis
− success: True or False indicaEng whether at least one match was found or not

8. Specifying shape descrip=ons
We use the term shape descripEon to disEnguish it from a rule descripEon. The la<er is a
textual descripEon that is used to explain the purpose of a rule to the user; it is not
interpreted by the SortalGI engine. Shape descripEons, on the other hand, follow a strict
format that allows them to be interpreted and matched by the SortalGI engine (see
Appendix A. A formal nota=on for shape descrip=ons for an explicaEon of the format).
Parametric shape descrip=ons
Shape descripEons are parametric in nature, that is, when adopted as the leJ-hand-side
(lhs) of a (shape) descripEon rule, a shape descripEon may contain one or more parameters
that can be matched onto parts of the descripEon under invesEgaEon. When adopted as the
right-hand-side (rhs) of a (shape) descripEon rule, a shape descripEon may also contain
parameter references although the parameters should have already been speciﬁed in the
corresponding lhs, such that the value of the parameter reference in the rhs can be taken
from the matching of the lhs. Obviously, shape descripEons that do not form part of a shape
descripEon rule should not contain any parameters or parameter references, otherwise
matching will necessarily fail.
Example (‘descripEon’ is the descripEon type name and ‘a’ is a parameter):
description: a
Shape descrip=on types
A single shape object or rule object may specify more than one descripEon. For example,
one descripEon may be used to constrain rule applicaEon while another may serve to count
the number of rule applicaEons performed on the shape object. In order to be able to
correctly match shape descripEons belonging to the lhs and the rhs of the rule object, shape
descripEons must be typed, that is, each shape descripEon that is not used as an a<ribute to
a point must be preceded by its type name (type name and descripEon are separated by a
colon). Shape descripEon types must be prescribed in the SGI Setup component (see
secEon 3. Star=ng on a SortalGI-based parametric model).
MulEple descripEons may share the same descripEon type. These can be collected in a
single line, using a verEcal bar to separate the various descripEons.
Examples:
min_width: 10
colors: “black” | “white”
Descrip=on literals
Literal values in descripEon may be numbers, double quoted strings or predeﬁned keywords.
The la<er include e, nil, pi, true and false. e and nil are equivalent and represent an ‘empty’
enEty. Depending on the context, the ‘empty’ enEty may be interpreted to denote zero, an
empty string or an empty tuple. The literals pi, true and false denote the numbers ‘π’, 1 and
0, respecEvely.
Examples:
status: true
list: e

Descrip=on tuples
While shape descripEons are speciﬁed in textual form, they can be structured as nested
lists/tuples. Tuples should be enclosed using either parentheses, angle brackets or square
brackets. A top-level tuple may have the enclosing brackets omi<ed. The enEEes within a
tuple should be separated using either commas or semicolons. Again, a top-level tuple may
have the separaEng marks omi<ed.
Examples:
segment: <(0, 0), (1, 0)>
cubes: (“l:”, 10, “c:”, (0, 0), “r:”, 0) (“l:”, 10, “c:”, (5, 5), “r:”, 45)
Descrip=on parameters
A descripEon parameter is a variable term that is speciﬁed by an idenEﬁer (any sequence of
le<ers, digits and/or underscores starEng either with a le<er or underscore) and embedded
in the lhs of a descripEon rule. Under rule applicaEon, the parameter will be matched to a
literal or a tuple. If the parameter forms part of a string expression (see “String expressions”
below), this literal can be any part of a literal string. If the parameter forms part of a tuple, it
matches a speciﬁc element of the tuple, unless it is signiﬁed by a kleene star (‘*’) or a kleene
plus (‘+’), in which case it can match any subsequence of elements of the tuple, respecEvely,
including or excluding an empty subsequence. The use of a kleene star or kleene plus
signiﬁer allows for the matching of variable length tuples.
Examples:
fixed_length: <“Fixed”, var1> <var2, var3> var4
variable_length: (0, 0) (x1, y1) remainder*
Parameter condi=onals
Any descripEon parameter may be speciﬁed a condiEonal that constrains the possible values
of this parameter. The condiEonal must follow the parameter and both must be separated
only by a quesEon mark (‘?’). The condiEonal may be either enumeraEve or equaEonal, or
specify a range. An enumeraEve condiEonal explicates a ﬁnite set of possible values. This set
must contain either all numbers or all (double quoted) strings, and the set must be enclosed
using curly brackets. An equaEonal condiEonal speciﬁes a numeric equality or inequality on
the parameter, in the form of a condiEonal operator (‘=’, ‘<>’, ‘<’, ‘<=’, ‘>’, or ‘>=’) and
operand. The operand must be either a number or a numerical expression (see “Numerical
expressions” below) operaEng on numbers, parameters—previously deﬁned—funcEons (see
“FuncEons” below) and/or references (see “References” below). Neither strictly
enumeraEve, nor strictly condiEonal, it is possible to specify a range of numeric values using
a minimum and maximum value enclosed in square brackets.
Examples:
yard: value?{nil, “default”}
rooms: <nrooms?>2, rooms>
range: a?[0, 10]
Numerical expressions
A numerical expression can be embedded in a parameter condiEonal (in the lhs of a
descripEon rule) or in the rhs of a descripEon rule. A numerical expression can operate on
literal keywords, numbers, numerical funcEons (see “FuncEons” below), parameters and

references (see “References” below). Numerical expressions may include the operators plus
(‘+’), minus (‘–‘), Emes (‘*’), divided-by (‘/’), modulo (‘%’) and to-the-power-of (‘^’), with the
usual operator precedence rules applying and the use of parentheses to override these rules
where necessary. Other operaEons are available in the form of numerical funcEons.
Example (‘vol’ and ‘length’ specify parameter references) :
volume: vol – pi^2 * radius * (length / 2)^2 + 4 / 3 * pi * (length / 2)^3
String expressions
A string expression in the lhs of a descripEon rule enables the idenEﬁcaEon of substrings in
the matching process. Here, a string expression is a concatenaEon of literals and parameters
(with or without condiEonal). A parameter can match any substring, condiEoned by the
literal components (and the condiEonal, if present). A concatenaEon of two parameters,
without a literal separaEng the two parameters, would not be possible, unless the ﬁrst
parameter has an enumeraEve condiEonal.
A string expressions in the rhs of a descripEon rule can include literals, parameter references
(see “References” below), numerical expressions (enclosed in parentheses) and funcEons
returning either numbers or strings (see “FuncEons” below). The result is the concatenaEon
of all components upon their evaluaEon into literal numbers or strings.
Examples (the two lines below may form the lhs and rhs of the same descripEon rule):
be: be1 be20.“, ”.be21.“-rafter beam in front, ”.be22.“-rafter beam in back” “with ”.c?=(be21 +
be22).“ columns”
be: be1 be20.“, ”.be21.“-rafter beam abutting ”.be22 “with ”.(c + 1).“ columns”
Tuple expressions
Tuple expressions allow one to append or prepend an enEty to a tuple, join two tuples or
add two tuples. The operaEons to append, prepend and join all take the same format: two
operands separated by a space. The appropriate interpretaEon is arrived at by looking at the
structure of the two operands. If the enEty shares a similar “structure” with the ﬁrst
element of the tuple, e.g., both are numbers or both are a tuple of similar structure, then
the enEty will be appended or prepended to the tuple depending on its posiEon with
respect to the tuple. If both operands are (nested) tuples, and the elements of both tuples
have the same structure, then a join operaEon will be assumed, combining the elements
from both tuples in a new, single tuple. If no structural similarity exists, then the expression
will instead be interpreted as a tuple ominng enclosing brackets and separator.
Adding two tuples adds the respecEve enEEes: if both enEEes are numbers they are
summed; if both enEEes are strings they must be idenEcal; if both enEEes are tuples and
have the same structure, then addiEon is applied recursively.
Examples (the la<er also includes a funcEon):
position: a + (1, 0)
positions: a last(a) + (0, 1)
Func=ons
FuncEons allow for addiEonal operaEons on numbers, strings and tuples, or a combinaEon
thereof. A funcEon returns a single value from any one of these three enEty types. Strictly
numerical funcEons include sqrt, sin, cos and tan, asin, acos and atan, taking a single number
as argument and returning a number. FuncEons operaEng on strings include determining the

length of a string and determining a left and right substring, with the length of the substring
speciﬁed as an addiEonal argument to the funcEon.
FuncEons operaEng on tuples include determining the length of a tuple, retrieving the first
or last element of a tuple, the minimum (min) and maximum (max) value inside a tuple,
retrieving a tuple of only unique elements, a tuple of pairs extracEng consecuEve elements
pairwise from the operand tuple, a tuple of pairs (segments) such that the ith pair is made up
of the ith and (i+1)th elements of the operand tuple, a tuple of tuples idenEfying loops in
the operand tuple and a tuple of tuples represenEng an adjacencies matrix. The la<er
funcEon takes two arguments, a tuple of ‘enclosures’ and a tuple of ‘connecEng’ elements.
Tuples of numbers can be considered as vectors, currently only vectors of length two or
three are considered. FuncEons on vectors require the diﬀerent vectors to have the same
length. These funcEons include determining the magnitude (mag) of a vector or the distance
(also mag) or angle between two vectors, adding (vectoradd) or subtracEng (vectorsubstract)
two vectors, taking the dotproduct or crossproduct of two vectors or scaling a vector by a
number (vectorscale).
Finally, a funcEon to generate a random number takes as input a tuple of two or three
numbers, with the ﬁrst two specifying the range and the opEonal third one the step. More
informaEon on funcEons is provided in Appendix B. Descrip=on func=ons.
Examples:
positions: a (random(0,10,1), 0)
References
We disEnguish three kinds of references. Firstly, parameter references are variable terms in
the rhs of a descripEon rule that reference variable terms (parameters) in the lhs of the
same (or another) descripEon rule. The value of the parameter reference in the rhs is the
value of the same parameter in the lhs upon the matching of the lhs.
Secondly, a descripEon reference is similar to a parameter reference but references a
variable term in another descripEon (that is part of the same rule). In such case, the
parameter name must be preceded by the descripEon type name in order to idenEfy the
appropriate descripEon and parameter. AlternaEvely, rather than referencing a speciﬁc
parameter, the enEre value of the descripEon can be referenced using the term value.
Finally, a shape reference similarly references data from the shape rule component of the
rule. In order to reference shape data, you must refer to the element type name (see Shape
element types below). However, this will only work if there is only one element of the
speciﬁc type, otherwise the reference will be ambiguous. In the case of points, you can
disambiguate the point by addiEonally specifying its label, provided the point has a label and
the label is unique (see example below).
Example querying the posiEons of two points with given labels:
constraint: a?>=mag(point.value:labelD.value=”1”, point.value:labelD.value =”2”)

Shape element types
Type

Name

points

point

Line segments

lineSeg

Plane segments

planeSeg

Labels/descripEons as point a<ribute

labelD

Appendix A. A formal nota=on for shape descrip=ons
The table below presents a formal notaEon for shape descripEons and the leJ-hand-side
(lhs) and right-hand-side (rhs) of shape descripEon rules in Extended Backus-Naur-Form
(EBNF), including examples. The same non-terminals serve to deﬁne the producEon rules for
a descripEon, an lhs and an rhs. Only when necessary are alternaEve producEon rules
deﬁned for the same non-terminal; these are then idenEﬁed by adding the terms
descrip7on, lhs and rhs, respecEvely, enclosed within angle brackets (‘<...>’), as a preﬁx to
the respecEve producEon rule.
typed-descripEon = type-name ‘:’ descripEon .
type-name = idenEﬁer .
descripEon = descripEon-enEty | descripEon-sequence .
descripEon-enEty = literal | top-level-tuple .
descripEon-sequence = ‘&’ descripEon-enEty ‘&’ { descripEon-enEty ‘&’ } .
literal = keyword-literal | number | string .
keyword-literal = ‘e’ | ‘nil’ | ‘pi’ | ‘true’ | ‘false’.
number = [ ‘–’ ] digit-sequence [ ‘.’ digit-sequence ] .
digit-sequence = digit { digit } .
digit = ‘0’ | ‘1’ | ‘2’ | ‘3’ | ‘4’ | ‘5’ | ‘6’ | ‘7’ | ‘8’ | ‘9’ .
string = ‘“’ { string-character } ‘”’ .
string-character = any-character-except-quote | ‘\’ ‘“’ .
Example descrip:on-en:ty:
“centrally divided, double 1-rafter beam in front and back”
Example descrip:on-sequence:
&e&0&“nothing”&
top-level-tuple = tuple | unmarked-tuple .
tuple = ‘(’ tuple-enEEes ‘)’ | ‘<’ [ tuple-enEEes ] ‘>’ | ‘[’ [ tuple-enEEes ] ‘]’ .
<descripEon>tuple-enEEes = tuple-enEty-sequence .
<lhs>tuple-enEEes = tuple-enEty-sequence | tuple-expression .
<rhs>tuple-enEEes = tuple-enEty-sequence | tuple-expression .
tuple-enEty-sequence = tuple-enEty ( { ‘,’ tuple-enEty } | { ‘;’ tuple-enEty } ) .
<descripEon>tuple-enEty = literal | tuple .
<lhs>tuple-enEty = numeric-expression | string-expression | tuple .
<rhs>tuple-enEty = numeric-expression | string-expression | tuple | funcEon-returns-tuple .
unmarked-tuple = tuple-expression | tuple ( tuple | keyword-literal ) { tuple-enEty } .
Example tuple:
(“l:”, 10, “c:”, (0, 0), “r:”, 0)
Example unmarked-tuple:
<" ", "O", "R0", "R1"> <"O", 1, 1, 1> <"R0", 1, 1, 0> <"R1", 1, 0, 1>
descripEon-rule-side = descripEon-rule-enEty | descripEon-rule-sequence .
<lhs>descripEon-rule-enEty = literal | parameter [ ‘?’ condiEonal ] | string-expression | top-leveltuple .
<rhs>descripEon-rule-enEty = numeric-expression | string-expression | funcEon-returns-tuple |
tuple-expression .
descripEon-rule-sequence = ‘&’ descripEon-rule-enEty ‘&’ { descripEon-rule-enEty ‘&’ } .

parameter = idenEﬁer .
idenEﬁer = ( le<er | underscore ) { ( le<er | underscore | digit ) } .
le<er = ‘A’ | ‘B’ | ‘C’ | ‘D’ | ‘E’ | ‘F’ | ‘G’ | ‘H’ | ‘I’ | ‘J’ | ‘K’ | ‘L’ | ‘M’ | ‘N’ | ‘O’ | ‘P’ | ‘Q’ | ‘R’ | ‘S’ |
‘T’ | ‘U’ | ‘V’ | ‘W’ | ‘X’ | ‘Y’ | ‘Z’ | ‘a’ | ‘b’ | ‘c’ | ‘d’ | ‘e’ | ‘f’ | ‘g’ | ‘h’ | ‘i’ | ‘j’ | ‘k’ | ‘l’ | ‘m’ | ‘n’ |
‘o’ | ‘p’ | ‘q’ | ‘r’ | ‘s’ | ‘t’ | ‘u’ | ‘v’ | ‘w’ | ‘x’ | ‘y’ | ‘z’ .
underscore = ‘_’ .
Example <lhs>descrip:on-rule-en:ty:
<“Fixed”, var1> <var2, var3> remainder
Example descrip:on-rule-sequence:
&a1&a2&a3&a4&a5&a6&a7&a8&
condiEonal = enumeraEon | equaEon | range.
enumeraEon = ‘{’ ( number-sequence | string-sequence ) ‘}’ .
number-sequence = number { ‘,’ number } .
string-sequence = string { ‘,’ string } .
equaEon = comparator comparand .
comparator = ‘=’ | ‘<>’ | ‘<’ | ‘<=’ | ‘>’ | ‘>=’ .
comparand = number | ‘(’ numeric-expression ‘)’ | parameter | reference .
range = ‘[‘ number ‘,’ number ‘]’ .
Example <lhs>descrip:on-rule-en:ty with enumera:on:
yard?{nil, “default”}
Example <lhs>descrip:on-rule-en:ty with equa:on:
<nrooms?>2, rooms>
numeric-expression = term { addiEon-operator term } .
term = factor { mulEplicaEon-operator factor } .
factor = base { exponenEaEon-operator exponent } .
exponent = base .
base = keyword-literal | number | ‘(’ numeric-expression ‘)’ | funcEon-returns-number |
parameter | reference .
exponenEaEon-operator = ‘^’ .
mulEplicaEon-operator = ‘*’ | ‘/’ | ‘%’ .
addiEon-operator = ‘+’ | ‘–’ .
Example numeric-expression:
vol – pi^2 * radius * (length / 2)^2 + 4 / 3 * pi * (length / 2)^3
string-expression = string-expression-enEty { ‘.’ string-expression-enEty } .
<lhs>string-expression-enEty = literal | parameter [ ‘?’ condiEonal ] .
<rhs>string-expression-enEty = base | string | funcEon-returns-string .
Example <rhs>string-expression:
“with ”.(c + 1).“ columns”
Example <lhs>string-expression:
“with ”.c?=(be21 + be22).“ columns”
<lhs>tuple-expression = tuple-append | tuple-prepend .
<rhs>tuple-expression = tuple-addiEon | tuple-extension .
tuple-append = { tuple-enEty } parameter ( ‘*’ | ‘+’ ) tuple-enEty { tuple-enEty } [ tuple-expression ]
.
tuple-prepend = [ tuple-expression ] { tuple-enEty } tuple-enEty parameter ( ‘*’ | ‘+’ ) { tupleenEty } .
tuple-addiEon = [ parameter ] ‘+’ basic-tuple-argument .
tuple-extension = { tuple-enEty } parameter { tuple-enEty } [ tuple-expression ] .

Example tuple-prepend:
h1 h2 H*
Example tuple-extension:
a1 last(a1) + (0, 1)
Example tuple-addi:on:
bedrooms + <1, [(“couple”, 0), (“double”, 0), (“single”, 1)]>
funcEon = funcEon-returns-number | funcEon-returns-string | funcEon-returns-tuple .
funcEon-returns-number = numeric-funcEon | length-funcEon | string-funcEon-untyped | tuplefuncEon-untyped | vector-funcEon | random-funcEon .
numeric-funcEon = ( ‘sqrt’ | ‘sin’ | ‘cos’ | ‘tan’ | ‘asin’ | ‘acos’ | ‘atan’) ‘(’ numeric-expression ‘)’ |
‘atan2’ ‘(’ numeric-expression ‘,’ numeric-expression ‘)’.
length-funcEon = ‘length’ ‘(’ ( string-argument | tuple-argument ) ‘)’ .
<lhs>string-argument = string | funcEon-returns-string | parameter | reference .
<rhs>string-argument = string-expression .
funcEon-returns-string = string-funcEon-returns-string | string-funcEon-untyped | tuple-funcEonuntyped .
string-funcEon-returns-string = ( ‘leJ’ | ‘right’ ) ‘(’ string-argument ‘,’ numeric-expression ‘)’ .
string-funcEon-untyped = ‘eval’ ‘(’ string-argument ‘)’ .
tuple-funcEon-untyped = ( ‘ﬁrst’ | ‘last’ | ‘min’ | ‘max’ ) ‘(’ tuple-argument ‘)’ .
<lhs>tuple-argument = basic-tuple-argument .
<rhs>tuple-argument = basic-tuple-argument | tuple-expression .
basic-tuple-argument = tuple | funcEon-returns-tuple | parameter | reference .
funcEon-returns-tuple = tuple-funcEon-returns-tuple | funcEon-returns-vector | string-funcEonuntyped | tuple-funcEon-untyped .
tuple-funcEon-returns-tuple = ( ‘unique’ | ‘segments’ | ‘pairwise’ | ‘loops’ ) ‘(’ tuple-argument ‘)’ |
‘adjacencies’ ‘(’ tuple-argument ‘,’ tuple-argument ‘)’ .
funcEon-returns-vector = two-vector-funcEon | proj-vector-funcEon | scale-vector-funcEon .
two-vector-funcEon = ( ‘vectoradd’ | ‘vectorsubtract’ | ‘dotproduct’ | ‘crossproduct’ ) ‘(’ ( vectorargument ‘,’ vector-argument | two-vector-argument ) ‘)’ .
vector-argument = ‘(‘ numeric-expression ‘,’ numeric-expression [ ‘,’ numeric-expression ] ‘)’ |
funcEon-returns-vector | parameter | reference .
two-vector-argument = ‘(‘ vector-argument ‘,’ vector-argument ‘)’ | parameter | reference .
proj-vector-funcEon = ‘proj’ ‘(’ ( vector-argument ‘,’ vector-argument ‘,’ vector-argument | threevector-argument ) ‘)’ .
three-vector-argument = ‘(‘ vector-argument ‘,’ vector-argument ‘,’ vector-argument ‘)’ | parameter
| reference .
scale-vector-funcEon = ‘vectorscale’ ‘(’ ( vector-argument ‘,’ numeric-expression | vector-numberargument ) ‘)’ .
vector-number-argument = ‘(‘ vector-argument ‘,’ numeric-expression ‘)’ | parameter | reference .
vector-funcEon = ( ‘mag’ | ‘angle’ ) ( ‘(’ vector-argument ‘,’ vector-argument ‘)’ | ‘(’ two-vectorargument ‘)’ )
random-funcEon = ‘random’ ‘(’ vector-argument ‘)’ .
Example func:on-returns-number:
length(“room”)
Example func:on-returns-tuple:
adjacencies(a4, a5 a6)

reference = reference-to-lhs | reference-to-rhs .
reference-to-lhs = [ ‘lhs.’ ] reference-designator ‘.’ ( ‘value’ | parameter | property ) [ ‘:’ ﬁlter ] .
reference-to-rhs = ‘rhs.’ reference-designator ‘.’ property [ ‘:’ ﬁlter ] .
reference-designator = idenEﬁer .
property = idenEﬁer .
ﬁlter = reference-designator ‘.’ property ﬁlter-operator ( number | vector | string ) .
ﬁlter-operator = ‘=’ | ‘<>’ | ‘<=’ | ‘>=’ .
vector = [ raEonal ] ‘(’ raEonal ‘,’ raEonal ‘,’ raEonal ‘)’ .
raEonal = [ ‘–’ ] digit-sequence [ ‘/’ digit-sequence ] .
Example reference-to-lhs:
indices.value
Example reference-to-rhs:
rhs.sections.radius:labels.label=“S”

Appendix B. Descrip=on func=ons
Numerical func=ons
func:on

input

output

abs

1 number

The absolute value of the number

sqrt

1 number

The square root of the number

sin

1 number

The sine value of the angle (in radians)

cos

1 number

The cosine value of the angle (in radians)

tan

1 number

The tangent value of the angle (in radians)

asin

1 number

The inverse sine of the number (in radians)

acos

1 number

The inverse cosine of the number (in radians)

atan*

1 number

The inverse tangent of the number (in radians)

atan2*

2 numbers

The inverse tangent of the raEo (in radians)

todegree

1 number

The value converted from radians in degrees

toradian

1 number

The value converted from degrees in radians

*atan versus atan2:
− atan takes 1 input and returns a result from quadrants 1 and 4
− atan2 takes 2 inputs (u, v) that specify a raEo u/v and returns a result from all quadrants
For example:
u

v

x = u/v

atan(x)

atan2(u,v)

2

1

2

1.1071487177940904

1.1071487177940904

-2

1

-2

-1.1071487177940904

-1.1071487177940904

2

-1

-2

-1.1071487177940904

2.0344439357957027

-2

-1

2

1.1071487177940904

- 2.0344439357957027

String func=ons
func:on

input

output

length

1 string

The length of the string

left

1 string and 1 number

The leJ substring of the speciﬁed length

right

1 string and 1 number

The right substring of the speciﬁed length

Tuple func=ons
func:on

input

output

length

1 tuple

The number of elements in the tuple

first

1 tuple

The ﬁrst element of the tuple

last

1 tuple

The last element of the tuple

min

1 tuple

The element of the tuple with minimum value

max

1 tuple

The element of the tuple with maximum value

unique

1 tuple

A tuple of only unique elements

pairwise

1 tuple

A tuple of pairs extracEng consecuEve elements
pairwise from the operand tuple;
e.g., (a, b, c, d) -> ((a, b), (c, d))

segments

1 tuple

A tuple of overlapping pairs extracEng
consecuEve elements from the operand tuple;
e.g., (a, b, c, d) -> ((a, b), (b, c), (c, d))

loops

1 tuple

A tuple of tuples idenEfying loops in the operand
tuple; e.g., (a, b, c, d, a, e, f, c) -> ((a, b, c, d), (c, d,
a, e, f)

adjacencies

2 tuples: a tuple of
“enclosures” and a tuple of
“connecEng” elements

A tuple of tuples represenEng an adjacency
matrix

random

1 tuple: either 2 or 3
numbers

A random number within the range speciﬁed by
the ﬁrst two operands; the opEonal third
operand is considered as a step value for the
random number generaEon

mag

2 vector tuples*

The distance between the two vectors

angle

2 vector tuples*

The angle between the two vectors
(counterclockwise angle from the ﬁrst to the
second vector) (in radians)

proj

3 vector tuples*: a direcEon
vector, a root vector and a
posiEon vector

A vector tuple represenEng the projecEon of the
posiEon vector on the line speciﬁed by the
direcEon vector and root vector

vectoradd

2 vector tuples*

A vector tuple represenEng the sum of the two
vectors

vectorsubtract

2 vector tuples*

A vector tuple represenEng the diﬀerence of the
two vectors

vectorscale

1 vector tuple* and 1 number A vector tuple represenEng the product of the
vector and the scalar

dotproduct

2 vector tuples*

The number resulEng from the dot product of the
two vectors

crossproduct

2 vector tuples*

A vector tuple represenEng the cross product of
the two vectors

*A vector tuple is a tuple of two or three numbers; any funcEon accepEng (one or more)
vector tuples will also accept a single tuple collecEng all operands

